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1 Introduction 

MPMAS is a software package for simulating land use change in agriculture and forestry. MPMAS 

uses mathematical programming to solve non-trivial land use decisions. With its mathematical 

programming decision-making component, MPMAS is firmly grounded in agricultural economics. It 

has been applied in a wide range of settings, including for irrigation water use in Chile and Ghana; 

soil fertility, poverty dynamics and producer organizations in Uganda; adaptation to climate 

change in Germany and Ethiopia; carbon sequestration in Brazil and innovation diffusion in 

Thailand and Vietnam. 

2 Software requirements and installation 

MPMAS is available as freeware software written in C++ that can be downloaded from http://mp-

mas.uni-hohenheim.de. The software is a single executable file that does not need installation. 

Both Windows and Linux versions are available. The source code for MPMAS is not yet publicly 

available but in the process of becoming open-source software. Researchers who are interested in 

applying MPMAS and who need additional features not currently available in MPMAS can get in 

touch by emailing mas@uni-hohenheim.de.  

This document describes how to use MPMAS under Windows 7 Professional with MS-Excel 2003 

and 20071 and under Linux-Ubuntu with LibreOffice 5.1: 

1. Extract the compressed tutorial files “TUT_0_basic” to any location on the hard disk: We 

suggest extracting the zip file to the main directory (usually C:/). The main folder of the 

tutorial package contains the various executables/Add-ins plus following subfolders:  

◦ Input: contains ASCII input files 

◦ Out: contains ASCII output files created when running MPMAS 

◦ xlsInput: contains Microsoft Excel workbooks from which the ASCII input files in the 

subfolder “input” are created. This is explained in the following sections. 

◦ odsInput: contains LibreOffice workbooks from which the ASCII input files in the 

subfolder “input” can also be created.  

2. Install the MPMAS macro tools in MS-Excel or LibreOffice: The MPMAS macro tools are 

used to design scenarios, create input files, and analyze simulation outputs. Both under 

Windows and Ubuntu, these tools have to be installed before they can be accessed in the 

toolbars of MS-Excel and LibreOffice. 

                                                 
1 

Note that users have recently reported difficulties running console applications such as MPMAS on Windows 10. 
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2.1 Installing mpmas tool in MS-Excel 

To install the add-in in MS Excel 2003, go to Tools>Add-ins. Click “Browse” and browse to the 

location of mpmas.xla. Select this file so that MPMAS appears in the list of Add-ins and make sure 

the checkbox is selected. The MPMAS add-in is now installed and any time you open Excel, the 

menu will appear as shown in Figure 1. In MS Office 2007 and later versions the add-in can be 

installed through Office button>Excel options>Add-Ins>Go.  

To run macros, the security setting in Microsoft Excel (Tools>Macros>Security in MS Excel 2003 

and Office button>Excel options>Trust Center>Trust Center Settings in MS Excel 2007) should be 

set to medium or low so that macros are enabled when opening files. 

In order for mpmas.xla to function fully, it is necessary to make sure a few of your computer’s 

settings are correct. First, the add-in requires the language settings be for English (US). To do this 

in Windows 8, use the Charms bar to search for Control Panel. In Control Panel, click on Change 

Input Methods under Clock, Language, Region. Click Options and change the default language to 

English (US). In Windows 7 or earlier, navigate through the Start menu to the Control Panel. Under 

Clock, Language you can change the default region and language to English (US).  

It is also important that the full extension for each of the input files is shown in Window’s Explorer 

(e.g. it should show ScenarioManager.xls rather than just ScenarioManager). As with the above, 

navigate to your version of Window’s Control Panel. Click on Appearance and Personalization and 

then Folder Options. Navigate to View>Advanced Settings and make sure that the box “Hide 

extensions for known file types” is not checked.  

Finally, make sure that Excel automatically calculates formulas and functions in your workbooks. In 

Excel 2007, this can be done by click on the Formulas tab. On the right of the screen, click on 

Calculation Options and choose “Automatic.” In Excel 2003, navigate in the toolbar as such: 

Tools>Options>Calculations and choose “Automatic.” 

2.2 Installing mpmas tools in LibreOffice 

For use in Linux, we created an alternative MPMAS Add-in that has to be added as toolbar in 

LibreOffice-Calc. It will then create input files from the workbooks contained in the subfolder 

/odsInput. To install the Add-in unzip odsmpmastools in the main folder and follow the 

instructions in the Readme file. 

Note that this installation has been tested only with LibreOffice 5.1 under Ubuntu 14.04 and 16.04. 

We will probably not upgrade our MPMAS tools to newer versions of Libre/OpenOffice or to other 

Linux operating systems. The reason is that development of LibreOffice-Basic, the equivalent to 

Visual Basic in MS-Excel, has recently been discontinued. 
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3 MPMAS input files 

MPMAS works with a set of text input files with the extensions .dat and .txt that are read and 

processed. Using the mpmas macro tools in MS-Excel or LibreOffice, it is possible to create these 

ASCII input files from the editable workbooks in /xlsInput and /odsInput, respectively. MPMAS is 

therefore different from many software applications, as the user is more or less free to organize 

the own data rather than the input data being entered through specially designed graphical user 

interfaces. 

Input files are written in workbooks and contain one or more worksheets with data and sheets for 

calculations and notes. The use of MS-Excel/LibreOffice workbooks is convenient, as workbooks 

can be easily linked and contain separate sheets for calculations and documentation of the model. 

Comments, explanations, and whole calculations can thus be kept together with the final input 

data, which greatly simplifies its use. 

 

Note: The procedure of creating .dat files from .ods workbooks is equivalent under LibreOffice-Linux.  

The general design of MPMAS input files follows some conventions: 

WORKSHEET NAMES: The name of each ASCII input file is derived from a scenario specified in 

ScenarioManager.xls/ods and the name of the respective worksheet. For example, if the prefix is 

set to “A” and the worksheet is named “MILP” then the ASCII input file will be called “A_MILP”. 

The worksheet names can therefore not be changed.  

ORDER OF THE WORKSHEETS: The workbooks used for MPMAS may contain multiple worksheets. 

The number of worksheets converted to ASCII is set in the upper table in ScenarioManage.xls/ods. 

If, say, two worksheets are to be converted then the workbook is opened and the first two sheets 

are taken. Worksheets with input data should therefore come first in the workbook, while 

worksheets with calculations and notes should come at the end.  

RED-COLORED CELLS: Workbooks in MS-Excel and LibreOffice need to be well documented by 

including sufficient explanation in the worksheets. When converting the various worksheets into 
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ASCII, everything except those values required by MPMAS code should be deleted. Red-colored 

cells in Row 1 indicate that the mpmas macro tools should clear the corresponding columns while 

red-colored cells in Column A indicate that it should clear the corresponding rows. See Section 5.2 

below for more information on using the mpmas tools complete this function. 

TEXT COLORS: Different text colors are used to make clear how the cell is calculated.  

 Blue numbers contain a formula and refer to cells in the same workbook  

 Red numbers contain a formula and refer to cells in other workbooks  

 Pink numbers are changed by ScenarioManager when converting files to ASCII  

 Black numbers are normal cells without formulas 

CELL NAMES: One of the advantages of using MS-Excel or LibreOffice is that workbooks can be 

linked. If workbooks are linked, then a change of a cell value in one workbook automatically 

changes this same value in all other workbooks linked to it. However, using references such as 

“=BasicData!$B$2” has the weakness that when inserting new columns or rows this reference is 

not updated in workbooks that are not currently open. This can be overcome by using textual cell 

names instead, e.g. give the cell $B$2 the name “Growth” using the ‘Name Manager' feature of 

Excel or LibreOffice.  

MPMAS has eight compulsory workbooks and six optional ones. The first workbook, 

ScenarioManager, is used to set up scenarios and to convert the input files to ASCII format. The 

second workbook is the mathematical programming tableau (Matrix), which organizes the 

decision-related data for all agents. This file is central to MPMAS. The function of all other input 

files is to calculate parameters that individual agents will insert in this matrix.  

The remaining workbooks can be divided into three groups2:  

 First, workbooks that create the population of agents, including their resource 

endowments (Population.xls), their spatial attributes (Maps.xls), and their knowledge of 

and access to innovations (Network.xls).  

 Second, workbooks containing parameters that are constant over the simulation run, 

including general parameters (BasicData.xls), crop water requirements (CropWat.xls), and 

the distribution of water rights over agents (WaterRights.xls).  

 Third, workbooks that simulate dynamics over time: demographic changes in agents’ 

household size and composition (Demography.xls), growth of trees and changes in input 

requirements (Perennials.xls), growth of animals and changes in yields and input 

requirements over time (Livestock.xls), changes in market prices (Market.xls), changes in 

the fertility of soils (Soils.xls), and finally, changes in the water supply (Routing.xls). 

                                                 
2
 For simplicity, we write here “.xls” but always refer to both .xls in Mpmas_Excel and .ods in Mpmas_LibreOffice. 
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The different workbooks are given below: 

 

4 Functions of mpmas macro tools 

MPMAS uses ASCII format for its input files. These pure text files are not convenient to edit, since 

they can't contain any headers, comments or formulas. The Mpmas macro tools help to convert 

your spreadsheets to the respective formats used by MPMAS. In this way, you first create your 

model input in Excel/LibreOffice and then convert it to ASCII using the macro tools. In addition, the 

tools contain features that allow you to optimize creation of simulation scenarios, analyze MPMAS 

output and solve stand-alone mixed-integer programming problems.  
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Mpmas.xla and the equivalent add-in in LibreOffice serve the following functions: 

 Deleting existing input and output files 

 Converting .xls (.xlsx, .xlsm) or .ods files to ASCII text format 

 Quick creation of simulation scenarios 

 Running the program executable (mpmas.exe or mpmas) 

 Solving a stand-alone MIP-problem (mpmasMipSolver.exe or mpmasMipSolver) 

 Analyzing saved agent LPs (.mip and .err files) 

 Solving a single-agent problem with different sets of RHS values and objective functions: 

useful for debugging and sensitivity analysis (XSingleAgents.xls/ods) 

 Analyzing simulation results for all agents (XResults.xls/ods) 

5 Using mpmas.xla3 

5.1 Deleting existing input and output files 

MPMAS input files are located in the subfolders /input/dat (text files with .dat extension) and 

/input/gis (ASCII maps). MPMAS output files are located in the subfolders /out (text files with .out 

extension) and /out/test (additional text output written out, when using MPMAS test flags). 

 

Mpmas.xla can be used for quick deletion of input and output files. In order, to do so you have to 

open ScenarioManager.xls. Clicking on “Delete all files” in the MPMAS dropdown menu will delete 

all input and output files from the respective folders. “Delete input files (.dat/.gis)” will delete all 

input files. “Delete input files (.dat)” will delete only .dat input files and leave the files from 

/input/gis subfolder (ASCII maps). If input maps for MPMAS were created in GIS and not Excel, it is 

thus possible to only delete .dat files and keep the map files in /input/gis as long as no changes are 

required. In this case it is also necessary to set the switch for including maps to zero in the top left-

hand box (cell D8) of the Scenario Manager. 

“Delete output files” will delete all output files, respectively. 

5.2 Converting .xls (.xlsx, .xlsm) files to ASCII format 

Mpmas.xla can convert your commented Excel input files from the /xlsInput folder to the model 

input text files and write them down into the respective subfolder of /input 

This operation can be executed by clicking on “Create input files” in the MPMAS dropdown menu 

while having ScenarioManager.xls open. The spreadsheet ScenarioManager.xls tells mpmas.xla 

                                                 
3
 And the LibreOffice tools that process files with .ods 
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which Excel workbooks to convert. The user must specify which workbooks in the top right table of 

the ScenarioManager.xls spreadsheet: 

 

The entry in the cell "Current directory" specifies the path to the folder containing the Excel input 

files (.xla inserts the path to the location of ScenarioManager.xls file). The cell "Main directory" 

specifies the main directory of the model folder, which is where the /input and /out subfolders are 

located (.xla inserts here the path to the parent folder "Current directory"). Normally, these paths 

are updated automatically when you open ScenarioManager.xls. If they were not automatically 

updated, then click on “Set path names” in the MPMAS dropdown menu. 

The column "Input file name" contains the names of the standard Excel files with MPMAS input. In 

the column "Include" the user has to specify which Excel workbooks .xla has to convert to the 

MPMAS input format. Values of the "Include" column may take either 0 ("not include") and 1 

("include"). Entries in column "Sheets" tell .xla how many worksheets (counting from the left) have 

to be converted from the respective workbooks. Column "File type" specifies the extension of 

Excel input files (.xls, .xlsx, .xlsm etc). 

After clicking on “Create input files,” the .xla will open the included files and worksheets and 

convert them to model input one by one. The transformations that .xla will perform, when 

converting files to model format is the following: 

1. Update cells listed in ScenarioManager.xls with provided values (procedure explained 

in the next section) 

2. Update links 

3. Delete formulas and break links 

4. Delete all rows and columns that contain cells either (i) marked with a red color or (ii) 

marked with green color and containing the word "delete" inside. For example, in the 

picture below rows 1 to 4 and 8 to 9 will be completely deleted, as well as columns A to 

C, H and I. Other information will appear in the MPMAS input files. This way the user 

may have comments and headers in his Excel files that won't be included to the 

MPMAS input files. 
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5. Save a copy of the worksheet (the original Excel files will remain unchanged) as a file in 

/input folder under the name <scenario name><worksheet name>.<input file 

extension> (.txt for Map files and .dat for others). If files with same names already exist 

in the /input folder the user will be asked: "Input files for the Scenario already exist in 

[…]. Would you like to delete these input files first?" Answering "Yes" will delete all 

input files (both .dat and .txt) from /input folder and save the newly created files there. 

When answering "No", the user will be asked to approve whether he wants to replace 

the same files names with the new ones (files with other filenames will remain). 

In addition, when converting files, .xla applies extra specific treatments for the Excel workbooks 

Matrix.xls and Map.xls: 

1. Matrix: Information used by the solver (objective function coefficients, integer info, 

etc.) is copied and pasted to the specific places in the input file MILP.dat. 

Therefore, .xla expects some predefined cell and range names to be present in the 

MILP spreadsheet of the Matrix.xls workbook. The full list of required names can be 

found in the Matrix.xls included in the tutorial model (see sheet "Notes"). Using the 

‘Name Manager’ feature in Excel 2007 ("Formulas" tab) you can see which cells and 

ranges these names are referring to. If you forget to specify one of the required 

names, .xla should normally remind you when converting Matrix.xls. 

2. Map: For the Map.xls workbook the .xla converts the worksheet only once, 

irrespective how many scenarios the user has specified (creation of scenarios is 

explained further). This is done due to the fact that the map normally doesn't vary 

between scenarios of one set. 

5.3 Quick creation of simulation scenarios 

ScenarioManager.xls and mpmas.xla can be used together to quickly create several simulation 

scenarios at a time. For creation of simulation scenarios, the user must use the bottom table in the 

ScenarioManager.xls: 
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This table needs to always have two top rows. The “Include” row under the parameter column 

tells .xla which scenarios to convert (value of one in the column for the respective scenarios 

means "convert" and 0 "not convert). The user can specify more scenarios, but convert only some 

of them. The “Prefix” row under the parameter column contains the prefix of scenario, which will 

be used in the names of .dat input files (naming was explained above). 

The rows below, which contain entries in the columns "Input file name" and "Cell name" will be 

used to define the simulation scenarios. Here, you specify in which input files .xla has to update 

which cells and which values to use for that. The .xla will take the values in Scenario columns and 

replace with them the entries in cells from "Cell name" in Excel files specified in "Input file name" 

column. For the example above, the .xla would replace the value of the cell named "p_maize" in 

the Market file with 2.00 for the "Scen1" scenario and with 4.00 for the "Scen2" scenario. 

5.4 Running the MPMAS  

Once all input text files have been created, one can proceed to running MPMAS. The .xla 

automatically generates a batch file called run_windows.bat, using the information provided in the 

top right table of ScenarioManager.xls: 

 

The cells "Location executable" and "Name executable" point to the MPMAS executable 

(mpmas.exe). The cell "Options" contains information on the additional test flags that must be 

used when running MPMAS. Note that the flags must be entered in Excel with ' in front (e.g. '-T1) 

(the full list of flags is provided in the "TestFlags" spreadsheet of ScenarioManager.xls, see below 

for more information).  

It is possible to run the batch file from the .xla menu directly (“Run MP-MAS”). Alternatively, one 
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can execute the batch file run_windows.bat directly from the model folder by clicking on it. Also, 

the file can be executed from the Windows command prompt (cmd.exe). The advantage of using 

the command prompt is that the command prompt terminal does not disappear once the model 

run finishes or if the model crashes. This may make it easier to identify possible error sources. 

If the model runs to the end, the message “Success: Simulation experiment [...] completed” will 

appear. A text file with the name of the scenario with the extension .err is created when the model 

runs. Here, one can also find hints for possible error sources. 

The output files are written to the directory /out. If test flags are used, additional test files will be 

written to the subdirectory ./out/test. Some of these test files allow for identification of input 

errors. 

Important test flags: '-T34' and '-T1' are often used flags if you have an error message. Write these 

flags in ScenarioManager.xls under “Options” (cell J10). For Excel to read it you must enter it as 

such “'-T34 '-T1”. The corresponding outputs will be written to the folder out/test. “'-T82” will 

print the Header Line to the MPMAS output files. 

5.5 Solving a standalone MILP-problem (mpmasMipSolver) 

The “Solve Matrix” option of the .xla add-in can be used to solve standalone MILP problems. The 

purpose of this feature is to give the model user the possibility to test the matrix before running 

the entire MPMAS model, which, especially at a more advanced stage of the modeling process, 

can take considerable time and have a much more complex validation process than in the 

standalone mode. For this, the second executable that comes with the model, 

mpmasMipSolver.exe is used. To run mpmasMipSolver.exe, it is necessary to have the Matrix.xls 

workbook opened. The RHS-vales need to be entered by hand in the matrix file (they are only used 

in the “Solve Matrix” mode and automatically overwritten when using mpmas.exe). Click on “Solve 

Matrix” in the drop-down add-in menu. In the dialogue box that appears, the solving mode needs 

to be chosen. It is recommended to use mode 4. To use the “Solve Matrix” option Matrix.xls has to 

be in the same format as when using MPMAS. 

After your problem was solved with mpmasMipSolver.exe, the .xla should normally automatically 

import the solution vector to the respective cells of your Matrix file (as is done when using the 

standard Excel-solver). Also the solution is saved in the .pri file in the same folder with 

mpmasMipSolver.exe. Use this file if the auto-import failed. 

5.6 Analyzing saved agent MP (.mip files)4 

While the MPMAS model is running, certain agent MP matrices might be saved automatically 

as .mip files, e.g. if the MP was infeasible or the objective function value was too low. If certain 

agent problems are not saved automatically, it still might be useful to analyze and re-solve MP for 

                                                 
4
 This feature is currently not available under LibreOffice-Ubuntu. 
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particular agents in order to look for mistakes in Matrix.xls, trying different RHS values, upper and 

lower bounds, etc. To save MP of particular agents you enter the farmstead ID with a negative sign 

at the bottom table in ScenarioManager.xls: 

 

Create your new input files and run MPMAS. The agent MILPs are saved in the ./out/test folder 

The name of the files provide information on the scenario, the time period, agent ID and 

consumption stage in the following order: 

<Scenario>_<Time Period>_<Agent ID>_<Consumption Stage>. .mip files contain the matrix 

information, .pri files contain the solution vector. 

Depending on which type of consumption module you are working with (basic or advanced 

consumption module), you will generate two or three sets of files corresponding to investment, 

production and—if advanced consumption—consumption stages. The lower number will always 

correspond to the investment stage, then the next one to the production, and the next one to 

consumption. 

Now you can analyze the single agent matrix and solve it again. For doing so there are two options 

available: 

Option 1: Using mpmas.xla, select “Check matrix files (err./.mtx)” in the MPMAS dropdown menu, 

then select the MP files to be solved and click “Solve again”. It is recommendable to solve in Mode 

4. Three different files per re-solved matrix will be generated in the MPMAS main directory. .mtx 

files contain the matrix information, .tst also the matrix information with some headers, and .pri 

files contain the solution vector. 

Option 2: Instead of directly solving the MP problem again, it is possible to use the option “Check 

matrix files (err./.mtx),” selecting “Go back to Excel” to convert your files to .xls first. The 

converted .xls files will be saved in the out/test folder. For solving the matrix again, locate the 

excel file in the main MPMAS directory and rename it as “Matrix.xls”. Open the file and use the 

“Solve Matrix” option of mpmas.xla. The matrix will solve again and the solution, solution vector 

and RHS will be updated. To check if the values were correctly updated, compare them with the 

values contained in the related .pri file.  

NOTE: when converting files back to excel and resolving again, the newly created .mtx files only 

capture the first 15 decimals of a number. This can lead to slightly different solutions. 
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The following graph provides a quick overview of the process: 

 

 

5.7 Solving a matrix with different RHS values and objective functions 

The XSingleAgents.xls workbook allows users to solve single-agent MILPs with 

mpmasMipSolver.exe with alternative RHS and objective function values (e.g. to perform farm-

level sensitivity analysis). 

In the sheets "RHS" and "Orow" of XSingleAgents.xls you can define sets of RHS-value and 

objective function values respectively. Than in sheet "XSingleAgents" you can set up your 

sensitivity scenarios by naming them and specifying which sets to choose. To run the scenarios you 

have to click on “Solve XSingleAgents.xls” in the MPMAS menu. For each scenario, new solution 

vectors (saved in .pri) will be calculated and automatically imported to the worksheet "Analyze". A 

further result summary with fewer variables can be found in the "Results" sheet (only in Excel). 

5.8 Analyzing results for all agents (Xresults.xls) 

MPMAS generates a huge amount of data. In order to compact and analyze this information 

several alternatives exist. Statistical packages, such as STATA, can be used and scripts (.do files) are 

available.  

In addition, the add-in feature “XResults.xls” is handy to gain an insight into model results. This 

tool requires that the workbook XResults.xls be open and that information on the location of files, 

the scenario name, etc. is provided in the sheet “Analyzer.” When clicking on the button in the 

add-in task menu, XResults.xls imports data from the output files, which contains the solution 

vector (u) and the available and used resources (k). The description for the variables of the 
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imported data can be taken from Matrix.xls. 

For first hand analysis of results in MPMAS, the xResults.xls sheet is very useful. Please note that 

you have to update the headers in your XResults.xls file whenever you added/changed our deleted 

activities and constraints in your matrix (just copy and paste from your matrix to your u and k 

sheets in XResults.xls) 

However, for big models and detailed analysis of results, the use of standard economics software, 

such as STATA, R or SAS, are recommended for analysis. 

5.9 Other functions 

Under “Other tools” in the .xla menu you can find some additional useful functions (not all 

functions are currently implemented in LibreOffice).  

Options “Find blank cells in selection” and “Fill blank cells with zeros” allow the user to quickly 

locate blank cells in MILP (which will cause errors when using mpmas.exe or mpmasMipSolver.exe) 

and fill them with zeros. The option “Insert rows/columns” allows the user to add the necessary 

number of columns to the MILP. “Freeze panes in Matrix” will quickly freeze panes in the top left 

corner of your MILP. 

6 MPMAS Output files 

Scenario results are written to the folder /out. A number of plain text files are created that contain 

different information on results from the model. MPMAS assigns a number of different codes to 

help understand what type of output is generated, which are then placed as the suffix of the nine 

output files. They are given in the following table: 

Table 1 Output file suffix codes 
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For the files with the suffix _p, _k, and _u (performance, available and used resources, and 

objective function solution), the format of the output file is relatively the same. Each row contains 

information on a separate agent (given by the Agent ID). The first thirteen columns for each p, k 

and u output file are the same, given in the following table: 

Table 2 Standard columns in _p, _k and _u files 

 

The _p file contains important information about the performance of different agents. These are 

often important metrics when analyzing results from different scenarios. The different codes for 

farm performance outcomes are given in the following table: 
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Table 3 Outcomes contained in performance files 

 

The _a file contains important information on agent population dynamics, in particular bankruptcy 

or out-migration. The basic structure of the _a output file is given in the following table: 

Table 4 Basic structure of _a output file 

 

Different codes indicate what the reasons are for an agent exits the population: 
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Table 5 Codes for reasons agents exit population 

 

The _d file contains information on innovation diffusions, which may be important as MPMAS is 

often used to assess adoption of innovations across an agent population. The information 

contained in this file is given in the following table: 

Table 6 Structure of _d output file 

 

7 Further reading and references 

The main reference when using/citing MPMAS is the journal publication of Schreinemachers and 

Berger (2011) in Environmental Modeling & Software. More documentation, including an 

expanded manual introducing the technical functions and structure of MPMAS, can be found on 

https://mp-mas.uni-hohenheim.de/documentation. In addition, a number of country-specific 

technical documentations can be found on the website, with a range of different applications: 

Germany: Troost, C. 2014. MPMAS Central Swabian Jura (Version 3.1) – Model Documentation.  

Includes information on: Agent expectations and learning; biogas production; additional livestock 

output (manure); policy interventions; farm succession; land markets; agent populations 

 

Uganda: Latynskiy, E. 2014. Agent-based simulation modeling for analysis and support of rural 

producers organizations in agriculture.  
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